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Instructions for CoralWatch database | Creating Bar
Graphs for Coral Health Score over time

To access this data, go to the CoralWatch Website and click on the Data Tab.
There are instructions for how to use the database here, and you can download
guidelines on how to use filters to find the data you want here.

When you download CoralWatch Data from the Atlas of Living Australia (ALA) it will
download a zip folder. Click on the ZIP to expand it and open the folder within. Here
there will be an excel file, this is your data.

< data g8 = @M &= e
Name ~  Date Modified Size Kind
o= data.xlsx_ 30 Nov 2022 at 5:25 pm 162 KB Micros...k (.xIsx)
> T images 5 Dec 2022 at 8:49 am -- Folder
.. README.txt 30 Nov 2022 at 5:25 pm 1 KB Plain Text
> T shapefiles 30 Nov 2022 at 5:25 pm -- Folder

When you open the excel file it will look something like this:

([ ] Aitosave @I D & DO v O -

Home Insert Draw Page Layout Formulas Data Review  View Acrobat @ Tellme

‘Q'Dv & Cut Calibri vt v A A T == v BwepTextv
&copy~ . — — — | = — | =
Paste o B I U+ Hiv dv A = = = | e= 3= Merge & Centre
A N
Al - fx  ProjectID

A B C D E F G H | J K L r

1 GrantlD External ID Organisatic Name Descriptiol Program  Sub-progra Start Date EndDate Funding
2 |9c55416¢~ CoralWatcl CoralWatcl In 2002, Cc CoralWatcl 2001-12-3: 0
3

h A


https://biocollect.ala.org.au/coralwatch
https://coralwatch.org/data/database-instructions/
https://coralwatch.org/wp-content/uploads/2021/09/FIND-data-instructions-Sept-2021.pdf

1. Go to the “CoralWatch Random Survey Tab”. This is where the data is. The
other tabs are supplementary information from the database.

44
45
46
47
48

Project Sites DwC Records CoralWatch Random Survey +

| Ready

You will now see something like this:

Al - fx  ProjectID

A B B [ E v 3

[ ) X L ™ N o 3 a [ s T u v w x v z M 8 ac 0 e
Light condi Depth (me Depth (fee Not availab Water tem Water tem Not availab Activity _ Comments Photo of th Country

location _used a

1
2 Select cora active  CoralWatcl -27.1626 1533682 Tangaloom Brokenclo3.0 5.84 Q Snorkeling high coral ¢ Australia  dd5abbss- true
3 Select coralactive  CoralWatcl -27.1626 153.3682 Tangaloom CoralWatcl Conservatic Monique G 2016-10-1¢11:45 AM _Broken clo(3.0 %.84 %30.0 %8.0 Snorkeling_high coral ¢ Australia  ddSabbss- true
4 Selectcoraactive  CoralWatcl -27.1626 153.3682 Tangaloom CoralWatcl Conservatic Monique G 2016-10-1¢11:45AM _Broken clo(3.0 %.84 %200 %8.0 Snorkeling high coral ¢ Australia ddSabbss- true
5 9¢55416¢- 63559da< 169836a1- 2001-12-3; Select coralactive  CoralWatcl -27.1626 153.3682 Tangaloom CoralWatcl Conservatic Monique G 2016-10-1¢11:45AM _Broken clo(3.0 .84 %200 %8.0 Snorkeling high coral ¢ Australia  ddSabbss- true
6 9¢55416¢- 6355(9da< 169836a1- 2001-12-3; Select corajactive  CoralWatcl -27.1626 153.3682 Tangaloom CoralWatcl Conservatic Monique G 2016-10-1¢11:45AM _Broken clo(3.0 %84 %200 %8.0 Snorkeling high coral ¢ Australia ddSabbss- true
7 Select corajactive  CoralWatcl -27.1626 153.3682 Tangaloom CoralWatcl Conservatic Monique G 2016-10-1¢11:45 AM Broken clo(3.0 %84 %300 %8.0 Snorkeling high coral ¢ dd5abbs8- true
8 Select cora active 1626 153.3682 Tangaloom Broken clof3.0 %84 %0.0 %s.0 Snorkeling high coral ¢ ddSabbss- true
9 Select cora active 626 153.3682 Tangaloom Broken clo3.0 E.u Zn.w :u 0 Snorkeling high coral ¢ ddsabbss- true

This is the dataset we will be analysing.
For this example, we will be analysing information from: Heron Island, Blue Pools,
Great Barrier Reef (QLD), Australia

There is a lot of information here, but I've highlighted a few key columns we want to
focus on in green. Most of the other information relates to the database setup.

Project Act Activity ID Startdate Enddate Descriptioi Status _Attributior Verificatio Latitude Longitude Centroid L Centroid Li Site Name_Site Extern Not applic: Group nam Participatii Submitted Observation Time

9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da- 8548ceed- 2001-12-3: Select cora active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl Conservatic Jenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl Conservatic Jenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3: Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM
9¢55416¢- 6355f9da-: 8548ceed- 2001-12-3; Select coral active CoralWatcl -23.5634 151.6697 Heron Isla CoralWatcl ConservaticJenny 8-May-21 08:15 AM

Light condit Depth (met Depth (feet Not availab Water tem) Water tem) Not availab Activity _Comments Photo of thi Country _location | used a GP: Coral No. _ Colour Code Colour Code Average. _Coral Type Species Photo

AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 182 B4 3 Boulder co
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 2 E2 B2 2 Boulder co
AM  Full sunshir 1.5 4.92 25 77 Snorkeling Amazing di' Australia  cbc2d693-2 true 384 BS 4.5 Branching
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 4 D2 D3 2.5 Branching
AM  Full sunshir 1.5 4.92 25 77 Snorkeling Amazing di' Australia  cbc2d693-2 true 5C D2 2 Branching
AM  Full sunshir 15 4.92 a5 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 6 D3 D4 3.5 Branching
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 7 D2 D4 3 Branching
AM  Full sunshir 1.5 4.92 25 77 Snorkeling Amazing di' Australia  cbc2d693-2 true 8 B2 B4 3 Branching
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 9 D2 2 Branching
AM  Full sunshir 1.5 4.92 25 77 Snorkeling Amazing di' Australia  cbc2d693-2 true 10 B4 BS 4.5 Branching
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 11 03 D4 3.5 Branching
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 12 ¢4 ce 5 Branching.
AM  Full sunshir 1.5 4.92 25 77 Snorkeling Amazing di' Australia  cbc2d693-2 true 13 E3 E4 3.5 Plate coral.
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazing dit Australia  cbc2d693-2 true 14 B3 B4 3.5 Plate coral.
AM  Full sunshir 15 4.92 25 77 Snorkeling Amazine dit Australia  cbc2d693-2 true 15 B4 BS 4.5 Plate coral.

Activity ID: This is the unique ID given to each CoralWatch Survey.

Site name: The location of the survey.

Observation date: The date the survey took place.

Water temperature: The water temperature when the survey took place.
Average: The average colour score for that individual coral surveyed on a scale of
1-6, six being the darkest and healthiest, and 1 being the lightest and

Coral type: The type of coral surveyed, either boulder, branching, plate or soft.

Note: Each row of data is for one individual coral



For this method we will be using Pivot tables.

1. Click back to cell 1 A and go Insert > Pivot table

o AutoSave @ oFF () B 9 v

Home Insert Draw Page Layout Formulas Data Review  View

ﬁ? ﬁ:IfPl T :v > I‘—CID o % @ 3D Models v HE‘.

23 SmartArt v

Pivot Recommended Table Data from Pictures Shapes Icons .- O
Tabl o - ple les Picture g Screenshot v L
Al - fx ProjectID
A B C D E F

il Project ID | Project Act Activity ID Start date End date Descriptior Sta
2 9c¢55416¢-16355f9da-: 169836al1- 2001-12-3: Select cora act
3 9¢55416¢-16355f9da-: 169836a1-2001-12-3: Select cora act
4 9c55416¢-16355f9da-: 169836al1- 2001-12-3: Select cora act
5 9c¢55416¢-16355f9da-: 169836al1- 2001-12-3: Select cora act
A QrRRA1AFd AARERfOAA-: 1RARAIAAT-2NNT1-12-2° Qalart rAra art

2. The following window will pop up... Click OK

Create Pivot Table
Choose the data that you want to analyse.
© select a table or range

Table/Range: 'CoralWatch Random Survey'!$A$1:$AN$44 %]

Use an external data source

No data fields have been retrieved.

Choose where to place the Pivot Table.

O New worksheet
Existing worksheet

Table/Range: %]

Cancel

This will appear in a new sheet down the bottom. I like to call mine “Pivot Table” or
“‘Data Analysis”

29
30
31

Project Sites DwC Records Sheet1 CoralWatch Random Survey +

w



3. You will be presented with a new sheet that looks like this

| | @ ® PivotTable Fields
| |

(@

To build a report, choose fields from the |
PivotTable Field List | Project ID
Project Activity ID
Activity ID
Start date

W 00 N O U s W N =

Tl o el
nilw N Bl

- Y Filters Il Columns

NN NNR B R B R
W N BREP, O WLOB-NOOW!

= Rows ¥ Values

W W w w N NNNNN
W N PO WO N U B

w w
Ul B

The pivot table fields section is what we will be using. You can drag and drop various
categories into each interactive section (Rows, Columns, Values etc) and it will
automatically generate a table based on this information)
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4. Drag observation date into the “Rows section”

ece PivotTable Fields

Group name

Participating as
Submitted by
@ Observation date

Time
Light condition

Y Filters 1l Columns

= Rows Y Values

5. We now want to group our dates based on years and months. To do this, go
to the Pivot Table Field Window and right click on the Row Quarters. Press
“‘Remove Field” to remove the quarters.

A B [} @ PivotTable Fields

Q

Row Labels E.

=2003 | Project ID
=Qtrl Project Activity ID
Jan Antivitv 1IN
22015 |
=Qtr3 Y Filters 11l Columns
Jul
=2016
=Qtr3
Sep
=2017

=Qtr2 =
Q = Rows Y Values = Rows Y Values
May

Jun | :Years Years

=Qtr2 Observation date R
| Move to Beginning
Ma
2021 y Move to End
@
AL — ; al
-qtr2 - Move to Report Filter u
Ma Tee——
y [ - ’ Move to Column Labels
=Qtrd Move to Values
Oct
2022 Remove Field
=Qtrd Field Settings

Nov



Optional: If you want to analyse your data based on other periods of time, click on
the first year of data, in this case A4, and go to Pivot Table Analyse > Group
Selection

Home

Pivot Table Name:

PivotTabled

A4

———
,_‘owoo\lmm.hwwn—-

Insert Draw

0

Options

= fx

Row Labels
22003 i
=2015
=2016
22017
=2018
22021
22022

Grand Total

Page Layout

Active Field:

Years

2003

C D

Formulas

o3

0%
Field
Settings

Data Review View

>

Group
Selection

Pivot Table Analyse

== F
oI
=X
=y =
Insert Insert Filter
Slicer Timeline Connections

+= Expand Field

-= Collapse Field

Tip: Make sure you are not clicking with the heading, but rather on the first row of
data. If you are in the heading the group selection tool will be “Greyed out” and
unavailable.

Click on group selection:

Review

‘ield

Field

View

EE

Pivot Table Analyse

= Filt:
Group Selection i

lﬁ.:ﬁ Ungroup...
Group Field

The “Grouping” Window will now
appear. For this activity we want to
groupings based on Months and Years
so we will select these two.

A4 z Fx ol
A B C D E F G
; Grouping
3 |RowLabels [ v| Count of Observation date
4 [art 25 - ) :
e ') By Starting at:  27/9/202116:0
6 a3 20 Endingat:  26/5/2022 16:0
7 | Grand Total 105
8 By:
9 -
10 Seconds
e Minutes
12
13 Hours
14 Days
s
16 |
- Quarters
:
19 E
i‘l) Number of days:
2

: cance
24
25

26 | [



Your table should now appear like this. Press the plus symbols to expand the years

to show the subcategories if you need to.

|Row Labels E_l

=2003
Jan
=2015
’ Jul
8 | =22016
9 Sep
10 | =2017
11 May
12 Jun
13 =2018
14 May
15 | =2021
16 May
17 Oct
18  =2022
19 Nov
20
21
22
23
24
25

Ui s WKN -

@ @ PivotTable Fields

Q|
Project ID
Project Activity ID
Activity ID
Y Filters Il Columns
= Rows 3 Values

Years

Observation date

Now we have our dates, we want to collect information about the Number of Corals
surveyed during this time.

To do this:

1. Drag activity ID down into the Values section of the pivot table. It should
appear as “Count of Activity ID” and your table should look like this:

PivotTable Fields

Vivgeet s

Project Activity ID

©  |RowLabels [ | Count of Activity ID

22003
Jan
22015

I Jul

Activity ID

Start date 22016

) Sep
Y Filters 1l Columns 22017
May

Jun

22018

May

22021
= Rows Y Values May

Years Count of Activit... Oct

Observation date

22022
Nov
Grand Total

6

6
118
118
20
20
168
102
66
251
251
207

52
17
17
787

Remember based on the structure
of our dataset, how one coral is
recorded per row in excel (Refer
Page 2). Therefore, if we count the
number of rows, this will give us the
number of corals. The Pivot table
has a function called count that
calculates this for us!

Activity ID is the unique ID given to
each survey. If we count the
number of times this appears per
month, this will

We could also use another variable
like coral number. It doesn’t matter

if we are using the count function —
this will give us the number of rows!




Let’s give this new variable a more meaningful name. Click into the column header
and change the next to “Number of corals surveyed” or “# corals surveyed”.

Dy L U v

X Number of corals surveyed
X v Count of Activity ID
B ¢ D
B c
: |surveyed -I
:ICount of Activity ID ] 6
* 6
s to

You can change the
Column Title by clicking
on the cell and changing
the Text in the Formula
Bar at the top

You'll also notice the table is Automatically providing sums per year. We don’t need

this information, only sums per month. To change this:

Right click on the year and go to Field settings > Change to None > press OK

2

3 Rowt Select > Pivot Table Field
4 (=200 Formulas >
5 )
6 | zo: Field Name: Years
= o v Subtotal "Years"
8 | =201
9 s« Expand/Collapse > | bl
100 e 208 ‘ Automatic | sum
11 m  Group...
12 ooy Custom Count
ngroup... {
13 | 2201 Sl © None Average
- M Max.
15 =202 Move > :
16 M Remove "Years" Min.
17 o
18 =202 Show Values as > Show items with no data
19 Ne
20 |Grand :
21 Show Details Number... Hide Cancel m

22 = .
= Field Settings... g :

You now have a nice clean table with summaries for each month:

Row Labels E] Number of corals surveyed

22003

Jan 6
22015

Jul 118
22016

Sep 20
22017

May 102

Jun 66
22018

May 251
22021

May 155

Oct 52
22022

Nov 17
Grand Total 787




6. We now we have our dates, and the number of surveys each month. Now we
want to integrate information about the average colour score.

Drag the “average” field into the values category. This is initially presented as a

“Sum”, so we want to change this to the average. Click on the ”i” info button to do
that.

A B C D E F G H J K L M N

Pivot Table Field

L
)
3 RowLabels | ¥ | Number of corals surveyed Sum of Average.
I | =2003 ]
5 [ i Q Source field: Average.
5 Jan 6 22,5
i 62015 Field name: Average of Average.
4 Jul 118 405 v Average.
3 | #2016 -
) Sep 20 77.5 Coral Type Summarise by = Show data as
0 =2017 -~ - ,
1 May 102 430 Sum
2 J 66 224 =5 =
3 _20:: Y Filters Il Columns Count

Average
4 May 251 947.5 Values v
5 | 22021 ax.
6 May 155 528.5 Min.
7 Oct 52 189.5 Product
8 | 22022

N

5 NGy o 5.5 Count Numbers
0 Grand Total 787 2893 StdDev
5 ¢
2
3
7 Number... Cancel m
5 = Rows Y Values
6
7 Years Number of coral...
8 ;
5 Observation date Sum of Average. —
0
1

Note: For Windows instead of Mac
If you are operating on a Windows computer rather than a Mac, this is slightly different.
Right click on sum of average > Go Value Field Settings > Average > OK

PivotTable Fields PivotTable Fields

Choose fields to add to repc
oot Choos: 10 add to report:

Source Name:  Average

Custom Name: | Sum of Average

Summarize Values By Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field

Sum

Count

Max

Min

Product

Normier Formt S




Lets do a little bit of cleaning up:

Firstly, average of average is a bit of a
funny name, so we want to change this
Column Title to “Average Colour
Score”.

B3 : X Average of Average.

A B C D

Form
1

2
3 |RowlLabels | ¥ |Av=r¥e of Average. al

You can change the Column Title by
clicking on the cell and changing the
Text in the Formula Bar at the top

B3 = Jx Average Colour Score
A B C D

1

2
3 |Row Labels |7v |Average Colour Score .|

4 2003 375

Secondly, there are also a few too
many decimals. We can shorten this by
using the “Decrease Decimal” Tool in
the Home tab. You can shorten it to one
or two decimal places, or whatever you
prefer!

ﬁ Conditional F

ﬁj’g Format as Ta
[iZ cellstyles v

Number v
$v% 9 & 9

Decrease Decimal

Tip: Make sure you select the data that
you want to make the changes too

\umber of corals surveyed _Average Colour Score

6 3.75

118] 3.43220339

20 3.875

102| 4.215686275
66| 3.393939394

Your table should now look like this. We now have for the Date, the number of corals
surveyed in that time period, and the average colour score from those surveys.

2

3 RowLabels E] Number of corals surveyed Average Colour Score
4 | 2003

5 Jan 6 3.75
6 | =2015

7 Jul 118 3.43220339
8  =2016

9 Sep 20 3.875
10  =2017

11 May 102 4.215686275
12 Jun 66 3.393939394
13 | =2018

14 May 251 3.774900398
15  =2021

16 May 155 3.409677419
17 Oct 52 3.644230769
18  =2022

19 Nov 17 4.029411765
20 |Grand Total 787 3.675984752

21

While it is useful to have a graph of Average Colour Score over time, it is also helpful
to know the number of survey surveys used to calculate the value. A larger number
of corals surveyed may give us a more accurate measure of colour score, due to the

larger sample size.

10




We are now ready to insert our chart!

7. Click anywhere your table. Go to Pivot table analyse > Pivot Chart

Home Insert Draw Page Layout Formulas Data Review View Automate Pivot Table Analyse Design Q Tell me [J Comments & Share
" . [Ee= ive Fleld: [id clear v = =]

Pivot Table Name: 0 v Active Field: Expand Field E? @ I:?} v g et v Iﬂ—ﬁ‘ v m E‘E g
PivotTable1 Options Average Colou Field Collapse Field Group Insert _Insert Filter Refresh  Change = . Fields, i Field /- Field

Settings Selection Slicer Timeline Connections Data Source li—s' Move Pivot Table Items & Sets List Buttons Headers
ca = fe v
A B c D E F G H 1 PivotTabl (]

al

2 Q

3 Row Labels E Number of corals surveyed Average Colour Score

4 |:‘2003 1]

5 Jan 6 3.75

6  =2015 Activity |

7 Jul 118 3.43220339

8 =2016

190 :‘ZDS:: » 3875 Y Filters Il Columns

11 May 102 4.215686275 Values

12 Jun 66 3.393939394

13 =2018

14 May 251 3.774900398

15  =2021

16 May 155 3.409677419

17 Oct 52 3.644230769

18 | 22022

19 Nov 17 4.029411765 = Rows 3 Values

20 Grand Total 787 3.675984752 Years Number of coral...

;; Observation date Average Colour...

23

24

25

2%

We now have a plot of the Number of Corals surveyed and the average colour score
on the same graph!

Row Labels E Number of corals surveyed Average Colour Score 300
=2003
Jan 6 3.75 250
=2015
Jul 118 3.43220339 2%
=2016 150
Sep 20 3.875 m Number of corals surveyed
=2017 100 m Average Colour Score
May 102 4.215686275
Jun 66 3.393939394 50
=2018 I I
May 251 3.774900398 0 == 8- L - - - - - L
22021 Jan  Jul Sep May Jun May May Oct Nov
May 155 3.409677419 2003 2015 2016 2017 2018 2021 2022
Oct 52 3.644230769
=2022
Nov 17 4.029411765
Grand Total 787 3.675984752
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Of course, plotting these variables on the same axis has made our Average Colour
Score variable look tiny as these values are small compared to the number of corals.
We need to plot this on a secondary axis!

¢ Double click on the count of activity ID bar until the format data point tab
comes up. Select, Plot series on Secondary Axis

Note: You many need to zoom in to do this as it is quite small.

Step 1: zoom in and Select | Step 2: Double click on The format data tab will
orange now pop up, click
“Secondary axis”

I I I |Format Data Point| @ = PivotChart Fields
38 8=g 3=5 8=

Plot Area ! J un M ay M ay I v Series Options
Plot Series On

lay Jun May May

Secondary Axis

Series Overlap == -27% o

Gap Width == 219% .

Now we have Average Colour Score appearing on the right-hand side as a
secondary axis

[ o 7
300 4.5

250
35
20
25
15
m Number of corals surveyed
L] (1
10 1.5 MAverage Colour Score
5
.5
0 0

Jan  Jul Sep May Jun May May Oct Nov

o
w

o o
[ N)

o
o

2003 20152016 2017 2018 2021 2022

T

Note: As Average colour score is in front, it is blocking the number of surveys, but
don’t panic! We are going to change the chart type to display them both at once.

Let’s change the formatting of the two variables to differentiate them a bit more.
We want to change only the Colour Score Variable from a Bar Graph to a line graph.
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1. To do this, Select the “Average Colour Score” orange variable,
Go to Design > Change chart type > Line > Line with Markers

Design Format Q Tell me J Comments 12!
o B
e i i
IR Switch  Select Change Move

Row/Column Data Chart Type Chart

Change Chart Type
K I8 M N o (2

Layout Formulas Data  Review View Automate Pivot Chart Analyse Design Format Q Tell me {2 Comments 2 Share

= il = ah= il - l.tﬁ?*' ’ ﬁ El,%ﬂf il

Row/Column Data ( |:D] Column [ 2

ES('New pivot'!$C$3,'New pivot'1$A$4:$A%$20, New pivot'!$C$4:$C$20,2) 2D Line

@D Pie
[E] Hierarchy

‘/\/ Statistical

‘ [ X Y (Scatter)
nﬂuu Waterfall
E Combo

N Save as Template...

Manage Templates...

D E E G H | J

4 |
250
35
0 3 o o
o Ao o f
_ o 25 3 ¥
2 mNumber of corals surveyed
(
0 1.5 MAverage Colour Score |
5
4 o 1 3D Line Line with Markers
05
8 0 0

Jan Jul Sep May Jun May May Oct Nov

9 200320152016 2017 2018 2021 2022 @
9 L 1 T J

o v |3
3 8

S
vVVvVYVYVYYVY

w
.
&

|
=
3

@

Your graph should now look like this!

300 4.5
4
250
3.5
200 3
2.5
150

2 mmmm Number of corals surveyed

1.5 ==@=Average Colour Score

1
I I 0.5
B 0
J

May un  May | May Oct Nov

100
50
O |
Jan Jul

2003 2015 2016 2017 2018 2021 2022

Se

O
p

Now we have both variables on our graph at once in a meaningful way.
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There are a final few changes we want to make to polish up our graph
(a) Change axis range
(b) Meaningful axis lables

Axis range: We want to make sure the axis scale matches what we use for
CoralWatch.

Double click on the axis and go to the “Format Axis” window on the right-hand side.

(Tip: It may be hiding behind the PivotChart Fields section”. Click on the il Section

D E E G H | J K |Format Axis| (%)

| | Axis Options Text Options
—
3 OO0 Ed

300

250 e |+ Axis Options

4
4
“mfg; v — f 3.5 ]
200 3 /| Bounds
2.5 © Minimum 0.0
150 [ :
2 mmmm Number of corals surveyed Maximum 45
[ ] 2
100 15 == Average Colour Score | | Units
1 I Major 0.5
I 0.5] | Minor 0.1
0 0 |

Horizontal axis crosses

[
o

Jul Sep May Jun May May Oct Nov [ |

| © Automatic
2003 2015 2016 2017 2018 2021 2022

| ; Axis value 0.0
I—. |

Maximum axis value

| | Display units None

PivotChart Fields Format Axis [x]
Axis Options Text Options Tip GO to AXIS Optlons and
o OB change the minimum to 1 and the
& maximum to 6.
v Axis Options
o I Also, change the Major Units to 1.
Maximum o - This.will help wit.h getting your
units gridlines in the right place
Major 1.0 0
Minor 0.5 %)
~ Number
Category Tlp- YOU can a|SO
i I remove the decimal
Decimal places: 2 pIaCeS on the aX|S by
Use 1000 Separator (,) SCFO”II"Ig dOWI"I |n the
Negative numbers: Format AXIS WIndOW tO
O -1234.00 “Number’
1234.00
(1234.00) . .
{12ac00) Expand this section and
Pl Catats change the number of
Ll decimal places to 0.
Add
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Axis labels: Finally, we also want to give accurate labels for our axis so people don't
mix up which side is which.

Go to Design > Add chart Element > Axis Titles and add (1) Primary Vertical and (2)
Secondary Vertical

Home Insert Draw Page

il e -

Add Chart  Quick Change
Element Layout Colours
Al
Chart 4 Add Chart Element *
©
nvine [IREI-IRY wiaw rdye Layvut roIHIvIaY wdia neview view AUWIIawe FIVUL vidI L ALIdIYDC wellyn rvlingat
. E=- v 1 b - SN
U - D = 5 = D= T I -
( Lill,. LIl Lll. Lill,. L. Ll
1[];1r Axes > | :
Il Axis Titles > ) -
|.|:|]1 Primary Horizontal
~ [ Chart title > =
fi Datalabels > | I, Primary Vertical F G H l J
Data Tabl > — .
4 Data Table |_|:|]:L Secondary Horizontal
f5 Error Bars > L - o
It Gridlines > |_|:|:|1|] Secondary Vertical 6
[hE‘ Legend > 5.5
More Axis Title Options... 5
5 li
.-/- Trendline > Bo| 00 4.5
4
- 150 35
9 20 3.875 mmmm Number of corals surveyed
{) 3
10 100 ==@==Average Colour Score
2.5
11 102 4.215686275
12 | 66 3.393939394 50 2
13 I 13
14 | 251 3.774900398 SRS
15 Jan  Jul  Sep May Jun May May Oct Nov
16 | 155 3.409677419 2003 2015 2016 2017 2018 2021 2022
17 I cn 2 cAANINTEA L I I el )

Write “Number of Corals Surveyed” on the left, and “Average Colour Score” on
the right.

300 6
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mmmm Number of corals surveyed

[
=
=
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[}
==@== Average Colour Score

Number of corals surveyed
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2003 2015 2016 2017 2018 2021 2022
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Congratulations! You have now created a graph for Coral Health Score over time for
Heron Island Blue Pools, or an area of your choice.

While it is useful to have a graph of Average Colour Score over time, it is also helpful
to know the number of survey surveys used to calculate the value. A larger number

of corals surveyed may give us a more accurate measure of colour score, due to the
lager sample size. Well done.
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200

150
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100 ==@==Average Colour Score

Number of corals surveyed
Average Coral Health Score

50

|l|| Iul
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Jan | Jul  Sep May Jun May| May Oct Nov

2003 20152016 2017 2018 2021 2022

Don’t forget to give your figure an informative caption i.e.
Figure 1: Average Colour Score and number of corals surveyed from Heron Island,

Blue Pools, Great Barrier Reef (QLD), Australia, between 2003-2022. This data was
recorded using CoralWatch Coral Health Charts.
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Extra formatting tips:

300 6
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N
o
o
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==@==Average Colour Score

Number of corals surveyed
=
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o

Average Coral Health Score

| II Il1

Jul  Sep 'May Jun May May Oct Nov

2003 2015 2016 2017 2018 2021 2022

You can make the graph neater by doing the following options:
e Adding borders for each axis
Inside tick marks for every 0.5 Coral Health Score (use minor
e Getting grey lines to match up with Coral Health Score rather than number of
surveys.
e Change font to Arial.
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